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1 Welcome to WinStudio

1.1 General Information

WinStudio is a powerful tool, that exploits key features of Microsoft®

Windows® NT/2000/XP and Windows® CE. These features enable you to
build full featured SCADA (Supervisory Control And Data Acquisition) or
HMI (Human Machine Interface) applications for your industrial
automation business.

1.2 Overview

This Getting Started Guide is intended for individuals using WinStudio for
the first time. This publication will help you to familiarize yourself with the
basic functions of WinStudio.

Note: WinStudio assumes that you are familiar with the basic
functions of the Windows NT/2000/XP operating system.
However, if you need assistance, we suggest using the Help
features in the Windows Desktop Start menu.

This Getting Started guide is divided into the following chapters:

• Chapter 1: Welcome to WinStudio: Provides a brief overview of the
WinStudio product, including its main features and system
requirements.

• Chapter 2: About this Publication: Provides information about this
publication as well as the used conventions and related publications.

• Chapter 3: Installing the Software: Explains how to install WinStudio
and CEView on your system.

• Chapter 4: Working with the WinStudio Interface: Describes all the
elements of the WinStudio development environment including menu
bars, toolbars, dialog elements, buttons, menus, etc.

• Chapter 5: Creating a WinStudio Application: Explains how to
create and edit an application. Furthermore, this chapter describes
how to create and modify objects, screens and communication drivers
as well as the procedure for testing your application.

• Chapter 6: Running the Web-Based Application: Explains how to
create and start a web-based application.

• Chapter 7: Running Applications from a Remote Station: Explains
how to manage applications remotely.
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1.3 About WinStudio

WinStudio applications consist of animated operator-oriented screens,
communication drivers (for PLC connection and I/O protocols, e. g.
BUEP, TCP/IP), database tags and additional modules such as alarm
monitors, mathematic and logic functions, trend charts, recipes,
schedulers, and the security system.

WinStudio applications interface with industrial I/O systems and other
Windows applications in the runtime environment using ODBC, DDE,
NetDDE, OPC, or TCP/IP protocols. You can also operate the application
by means of a standard web browser (Internet Explorer or Netscape).

The product consists of two parts:

• The development system software which runs on a desktop, laptop or
an industrial PC running Windows NT/2000/XP.

• The runtime system software which runs on any workstation running
Windows NT/2000/XP or Windows CE.

Note: The runtime system software for Windows CE (CEView) is
usually pre-installed on your HMI. If necessary, you can
update the development system software by an automatic
download.

You can run WinStudio applications on your development workstation or
download it to your target workstation (via a serial or TCP/IP connection)
and from there start the runtime under WinStudio or CEView. If the
application is running, the I/O units configured by the connected control
are retrieved by means of the parameters entered in the application and
loaded into the control. Then, the control reacts to the data by displaying,
saving or updating them.

1.4 Main Features

WinStudio provides the following properties and functions:

• Web interface: Allows you to visualize screens for a standard web
browser (Thin Client) and exchange data via the Internet/Intranet with
the TCP/IP protocol.

• WinStudio applications which run on all Windows platforms
(Windows NT/2000/XP and Windows CE).

• Online and remote management of the application and configuring
(download/upload, commands, system and network diagnosis as well
as debugging)

• An integrated development environment with toolbars, dialogs, menus,
and customizable toolbars

• A user-friendly screen editor that enables you to modify an application
also during the runtime (online configuration).

• A library of more than 100 symbols and dynamic objects, such as:
frames, icons, motors, pipe elements, meters and gages, LED-style
indicators, text and numeric displays, control symbols, sliders,
switches, pumps and valves, pushbuttons, vehicles.

• A cross-reference tool to locate tags throughout the application

• Active-X object containers
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• Full-featured objects with dynamic and customizable object properties
such as bar graphs, color change, resizing, position, rotation,
hide/unhide, commands, hyperlinks and text or value input/output

• An open architecture API that exchanges the used tag values with
external programs (Microsoft.NET architecture-compliant).

• Easy merging of screens and configuration worksheets into other
applications

• Screen and object password-protected runtime security (256 levels)

• OPC Client and Server modules with integrated OPC Browser, DDE
Client and Server modules, as well as TCP/IP Client and Server
modules to exchange data and configure a system redundancy.

• Standard protocols such as BUEP, TCP/IP

• Mathematic and logic expressions as well as a scripting language with
more than 200 functions

• Online/historical alarms, trends, recipe and report functions (text, XML,
or RTF-formatted ASCII or UNICODE)

• Event scheduler (based on date, time or tag modifications)

• Translation editor to translate applications into different languages.
Online language conversion during runtime is possible.

• Database Spy window (local or remote) to monitor or force tag values
and to execute functions (test environments)

• LogWin modules (local and remote) to monitor messages initiated by
DDE, OPC and TCP/IP transactions, to activate modules, to modify
tags etc.

• A powerful and flexible database system with Boolean, Integer, Real,
and String tags, array tags, classes (data structures) and indirect tags
and pointers

• Contains functionalities to import tags from controls and applications
such as ASAP, ISaGRAF, SteepleChase and Think&Do

• Functions to dial-up, trigger and monitor hang-up dial-up connections
with remote stations and RAS servers

• Functions to send emails (in WinStudio or CEView)

Note: WinStudio provides different product types (e. g. ranging from
Advanced Server to Lite) for different levels of an application.
However, WinStudio does not support some features in
certain product types (such as CEView).
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System Requirements
To develop and run applications with WinStudio, the following hardware
and software components must be available:

• IBM-compatible computer with an Intel® Pentium II-compatible
processor or higher

• Windows NT/2000/XP operating system for development

• Windows NT/2000/XP or Windows CE 3.00 or Windows CE.NET
operating system for runtime

• Minimum of 128 MB RAM (256 MB or higher recommended)

• MS Internet Explorer 4.0 or higher

• Minimum of 150 MB free hard disc space (required for the program
without any application files); (300 MB recommended)

• CD ROM drive: This device can be installed on another connected
computer.

• Standard keyboard with function keys F1 to F12

• Parallel printer port (optional)

• 100 % IBM-compatible VGA or SVGA graphic card with 32 MB video
RAM (VRAM) (optional for Runtime when running a web-based
application)

• Microsoft-compatible pointer device (such as mouse, trackball or touch
screen)

• One or two COM ports and adapter for downloading applications
(optional)

• Ethernet connection for downloading applications (optional)

Note: WinStudio is UNICODE-compliant and will not run on a non-
UNICODE-compliant operating system (such as Windows
9x/ME). You can, however, run the Web Thin Clients of
WinStudio applications on non-UNICODE-compliant systems.
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2 About this Publication

2.1 General Information

This chapter provides the necessary information for a better
understanding of this WinStudio Getting Started Guide and other
WinStudio publications:

• Text Conventions: Describes the conventions for text formattings
used in this publication to help you read and assimilate information
quickly.

• Mouse and Selection Conventions: Describes the conventions used
in this publication for using a mouse and selecting objects in a
Windows environment.

• Windows Conventions: Describes the conventions used in this
publication for working in a Windows environment.

• Related Publications: A list of further WinStudio publications
(available on the WinStudio installation CD ROM) containing related
information about WinStudio.

2.2 Text Conventions

This publication uses special formattings to help you quickly identify
certain items as follows:

• Titles, labels, and new terms are indicated using italic text.

• File names, messages and screen texts are indicated using bold and
monospaced text (For example: D:\Setup.exe).

• Variables and information you must provide are indicated using bold,
italic and monospaced text enclosed in < and > brackets (for example:
Run the <driver name>.exe file indicates you must provide the
name of the driver file)

• Buttons, menu options, and keyboard keys are indicated in bold.

• Text requiring special emphasis is indicated in bold italic.

• Some information is divided into Tip, Note and Caution boxes as
follows:

• Tips provide useful information to save development time or to
improve application performance.

• Note provides additional information related to the surrounding text,
usually the text just preceding the note.

• Cautions provide information necessary to prevent damage or
problems, when running the application.
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2.3 Mouse and Selection Conventions

As most of the PCs used for application development are Windows-
based, this publication assumes you are using a mouse. This publication
also assumes that your mouse is configured, so that the left button is the
primary button and the right button is the secondary button.

This publication uses the following mouse and selection conventions:

• Double-click means to quickly click twice on an object with the left
mouse button.

• Right-click means to click once on an object with the right mouse
button.

• Click and Select both mean to click once on an object with the left
mouse button. In general, you click on buttons and select from a list.

• Select also means to use your pointing device (mouse indication on
the screen) to highlight or specify an item on the computer screen.
Selecting an object with a touch screen is usually the same as
selecting with a mouse, except that you use your finger to touch
(select) a screen object or section.

• You can also use keys to select objects/options. For example, you can
use the TAB key to move between the options, the Enter key to open
menus, and the Ctrl or Alt keys in combination with a letter key (for
example, Ctrl+S) to select a menu option having an underlined letter
(Save).

• Drag means using your mouse to move an object on the computer
screen to a new location. For this, position your mouse cursor on the
desired object and press the left mouse key. Now, by pressing and
holding the right mouse key you can move the object to another
location. Thereby, usually, the outline of the object will move along with
the cursor. When the object is positioned on the desired location,
release the mouse button.
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2.4 Windows Conventions

This publication uses the following Windows conventions:

• Dialog boxes (or dialogs) are windows, that allow you to enter data.

• Text boxes (or fields) are areas in dialogs, where you can enter texts.

• Radio buttons are white circles, in which a black dot ( ) appears or
disappears, when you click on the option. Typically, the black dot
indicates that the option or function is enabled (active); the absence of
a black dot indicates that the option or function is disabled (inactive).
Usually, radio buttons are arranged as field, whereby only one option
can be selected at the same time; all other options are then disabled.

• Check boxes are white squares, in which a check ( ) appears or
disappears, when you click on the button. Typically, the check
indicates, that this option is enabled (active); the absence of a check
indicates that the option is disabled (inactive). It is possible to select
several options at the same time.

• Buttons are icons in boxes, that appear "pressed", when you click on
them.

• Lists are panes (white boxes) in windows or dialog boxes containing
two or more selectable options.

• Combo boxes can be opened/closed when clicking on the arrow key;
then, an option list is indicated.

Klicken Sie hier, um
die Liste anzuzeigen

Combo Box.word

Fig. 2-1: Using a Combo Box

• Interface or Development environment refers to the entire
WinStudio window.

• Dockable windows are windows, that you can drag to the edge of
another window and thereby merge the two windows to one.

• Toolbars are dockable windows, that contain only buttons and text
boxes.

Note: The dialog boxes and procedures described in this publication
are valid for the operating system Windows 2000. Some terms
or views may vary according to the operating system used and
depend on the individual country versions and languages.
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2.5 Related Publications

The following publications are still in preparation and will be published on
the WinStudio CD ROM as soon as possible.

Title Short text Part no.

Rexroth WinStudio
Bedien- und Programmieranleitung

DOK-CONTRL-WIS*PC**V06-AW..-DE-P In preparation

Rexroth WinStudio
Operator and Programming Guide

DOK-CONTRL-WIS*PC**V06-AW..-EN-P In preparation

Fig. 2-2: Related publications

Note: For information about the single menu bars, toolbars, dialog
elements, buttons and menus refer also to the WinStudio
Online Help.
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3 Installing the Software

3.1 General Information

This chapter provides the necessary instructions for installing, starting
and uninstalling WinStudio and CeView.

• Installing WinStudio: Explains how to install WinStudio on your
computer.

• Starting WinStudio: Explains how to run WinStudio.

• Installing CEView Software: Explains how to install CEView on your
computer.

• Uninstalling WinStudio: Explains how to remove WinStudio and
CEView from your computer.

3.2 Installing WinStudio

WinStudio provides development tools for all WinStudio applications and
the runtime. Besides the runtime for Microsoft Windows NT/2000/XP
operating systems an emulator is also available to operate applications
for Windows CE.

You can install WinStudio either from CD ROM or download the newest
version of the installation files via the Internet. The Homepage for
WinStudio is (http://193.108.217.183/atproducts/plcwebsite/). For
Windows CE applications you use WinStudio to download CEView
(runtime software) to the Windows CE HMI using a serial or TCP/IP link.

The WinStudio installation program creates automatically all necessary
directories and subdirectories and copies the required files to your
workstation. Furthermore, it creates the necessary icons in your desktop
folder.

Note:

• You must have administrator rights on a
Windows NT/2000/XP workstation to install WinStudio.

• You must uninstall all previous versions of WinStudio or
change the installation path of the new version. Also, you
cannot install and operate the same version of WinStudio
in two different paths of your computer.

Use the following procedure to install WinStudio from the CD ROM:

1. Turn on the power to your development computer (Windows NT,
2000, or XP), and ensure that no other programs are running.

2. Insert the installation CD ROM into the CD ROM drive.

Note: Now, a CD browser window should be automatically opened. If
not, you can start the installation manually via the Windows
Explorer. Navigate to the D:\Installation directory, where
D is the letter of your CD ROM drive. There, run the
Setup.exe file.
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3. Double-click on the Installation folder, and then double-click on the
WinStudio icon to start the InstallShield® Wizard.

4. Follow the instructions provided by the InstallShield Wizard and apply
the displayed indications or modify them according to your
requirements.

5. If you are prompted to restart, select the Yes, I want to restart my
computer now radio button, then click on OK.

3.3 Starting WinStudio

To run WinStudio, double-click on the WinStudio shortcut on your
desktop or select Start −>−>−>−> Programs −>−>−>−> Rexroth −>  −>  −>  −>  WinStudio ->
WinStudio.

Start_WinStudio.bmp

Fig. 3-1: Starting WinStudio

Tip: You can run the WinStudio development environment with any
display resolution. However, it is recommended to use a
resolution of at least 800 x 600 (or higher) with more than 256
colors for a more pleasing environment. The resolution of your
application (screen size) is independent of the operating
system resolution.
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3.4 Installing CEView Software

When installing WinStudio under Windows NT/2000/XP the CEView
runtime files are stored in the following folder:
<WinStudio Folder>\Redist\<WinCE version>\<Processor Type>\

where:

• <WinStudio Folder> is the installation directory selected during the
installation (C:\Program Files \ Rexroth \ WinStudio is the
default directory for an English operating system).

• <Processor Type> is the processor platform used in your CE panel.
WinStudio provides CEView runtime for all processor platforms
supported by the WinCE operating system. Bosch Rexroth supports
Arm, Pocket-Arm, and X86.

• <WinCE version> is the corresponding Windows CE version. Bosch
Rexroth operator terminals use WinCE 4.2.

To install CEView, proceed as follows:

1. Power-on the Windows CE device and launch the Remote Agent
dialog, if it is not automatically started. For this, you must copy the
CESERVER.EXE file of your development workstation from the
\<WinStudio Folder>\Redist\<WinCE version>\
<Processor Type>\BIN.

2. Paste this file into the \<non-volatile> directory of your WinCE
device and start this program.

Note: There are different ways to copy this file into your WinCE
device, e. g., by using ActiveSync. If you need assistance to
do so, please contact the corresponding hardware
manufacturer.

After executing the CESERVER.EXE file, the Remote Agent dialog opens
on your WinCE device.

3. Click on the Setup button in the Remote Agent dialog and select the
desired communication (serial or TCP/IP) to link your CE device and
your development workstation (Windows NT/2000/XP Computer).

Note: To accelerate the data exchange between the two
workstations, WinStudio recommends to use the TCP/IP
communication.

4. Start WinStudio on your development workstation.

5. Select Project −> −> −> −> Execution Environment from the main menu bar.
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6. If the Execution Environment dialog appears (see Fig. 3-2), select the
connection type (Network IP or Serial Port), choose the
corresponding parameters or enter the TCP/IP address of your CE
device.

Ausführungsplattform.bmp

Fig. 3-2: Execution Environment dialog box

7. Click on the Connect button to connect WinStudio to the WinCE
device. For this, please observe the settings of the communication,
such as BaudRate, Com Port etc. or the conventions of a TCP/IP
connection  with regard to the address area.

Click on the Install. System Files button in the Execution Environment
window (register Target) to download the CEView files to the WinCE
device.

3.5 Uninstalling WinStudio

If you must remove WinStudio from your computer, proceed as follows:

Caution: Before uninstalling WinStudio, be sure to back-up any files
from the …\ WinStudio\ Projects\ folder. Also be sure
to have the current (newest) WinStudio installation CD, so that
you can re-install WinStudio.
You will lose the product softkey license, when you uninstall
WinStudio!
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1. Select Start →→→→ Settings →  →  →  →  Control Panel, to open the Control
Panel.

Öffnen_der_Systemsteuerung.bmp

Fig. 3-3: Opening the Control Panel

2. Double-click on the Add/Remove Programs icon in the Control
Panel.

3. Select WinStudio from the list and remove the program.

4. Confirm the request to remove the software by clicking on Yes.
The Uninstall Shield Wizard uninstalls now WinStudio.

Entfernen_des_Programms.bmp

Fig. 3-4: Removing the program
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5. If the message Uninstall successfully completed appears and the OK
button becomes active, click on OK. Verify that WinStudio is no
longer listed in the Add/Remove Programs dialog.

6. Now, close the Control Panel environment completely.

7. Open the Windows Explorer and browse to the directory containing
the installation directory of WinStudio.

8. Verify that all files have been deleted. Possibly, you can manually
delete the complete folder.

Note: The uninstall tool should not delete the project data that you
created in the …\ WinStudio\Projects\ directory.
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4 Working with WinStudio

4.1 General Information

This chapter describes the WinStudio Development environment:

• Overview: Provides a brief description of the tools and interfaces of
the WinStudio development environment.

• Title bar: Describes the title bar.

• Status bar: Describes the status bar.

• Menu bar: Describes the different menu options that you can access
from the WinStudio main menu.

• Toolbars: Describes the WinStudio toolbars.

• Workspace: Describes the WinStudio workspace.

4.2 Overview

WinStudio uses standard, Windows-like tools and interfaces to make the
product user-friendly. WinStudio also uses an integrated, unique
development environment (see figure) for easy access to tools and
information.

WinStudio_Entwicklungsumgebung.bmp

Fig. 4-1: WinStudio development environment
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The development environment consists of the following areas:

• Title bar: Indicates the active edited screen or configuration sheet.

• Status bar: Provides quick access to current information.

• Menu bar: Contains the main product options, which you can easily
access using the cursor or your keyboard keys.

• Auxiliary toolbars: Contains "Shortcuts" to the main commands in the
development environment.

• Graphic toolbars: Contain features and tools used to create or edit
objects and dynamics in the application screen.

• Workspace: Shows the tree-structure of the application. From there,
you can select all elements of an application.

• Database Spy window: Provides a debugging tool,  which you can use
to monitor and modify the tags of an application. Furthermore,
functions can be executed.

• Output window: Displays messages to debug or test an application.

• Displays / Configuration sheets: Provides an area where you can
edit screens and configuration sheets.

Note: The preceding figure shows the default settings of the
indicated elements in the development environment.

You will find an overview of the used toolbars via menu View ->
Toolbars:

WinStudio_Werkzeugleisten_Pop-Up_Menü.bmp

Fig. 4-2: Pop-up menu WinStudio toolbars
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4.3 Using the Title Bar

The title bar located along the top of the WinStudio window displays the
WinStudio icon, the product name and the name of the active screen or
configuration sheet.

Typische_WinStudio_Titelleiste.bmp

Fig. 4-3: Typical WinStudio title bar

The title bar contains three buttons (from the left to the right):

• Minimize button ( ): Click on this button to minimize the WinStudio
window.

• Resize/Maximize button ( / ): Click on this button to toggle between
the two options:

• Resize: Resizes the WinStudio window to the last used seize

• Maximize: Maximizes the WinStudio window to fill your computer
screen

• Exit (or Close) button ( ): Click on this button to save the database
automatically and to close WinStudio. If a screen or configuration
sheet was still not saved, WinStudio prompts you to save your work.
This button function is similar to the Exit command in the File menu.

Note: Closing the development environment does not close the
WinStudio runtime tasks. To close the runtime tasks, click on
the Stop icon  on the Execution toolbar or select option
Project / Stop Application in the main menu bar.
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4.4 Reading the Status Bar

The status bar located along the bottom of the WinStudio window
provides fields containing the status of the keyboard and information
about objects in the active screen or configuration sheet (if available).

Beispiel_Statusleiste.bmp

Fig. 4-4: Example status bar

The fields are arranged as follows (from the left to the right):

• Hint field: Provides a short description of any toolbar button or object
touched by the mouse pointer.

• Caps Lock field: Indicates whether the keyboard Caps Lock key is on
(CAP) or off (empty).

• Num Lock field: Indicates whether the keyboard Num Lock is on
(NUM) or off (empty).

• Scroll Lock field: Indicates whether the keyboard Scroll Lock is on
(SCRL) or off (empty).

• ID field: Displays the ID number of a selected screen object.

• Screen Coordinate field: Displays the current position of the cursor
(or mouse pointer) on the active screen. If you have selected an
object, the coordinates of this object are indicated in this field. Where:
X is the number of pixels from the left edge of the screen and Y is the
number of pixels from the top of the screen.

• Object Size field: Indicates the size (in pixels) of the selected object.
W is the width and H the height (in pixels).

• No DRAG field: Indicates whether dragging is disabled (No DRAG) or
enabled (empty).

• You might want to disable dragging to change the object properties of
an object without moving it from its current location.

Tip: You can enable and disable dragging by pressing the key
combination Ctrl+D. When dragging is enabled, you can click
on any object and while pressing the mouse button you can
use the arrow keys on the keyboard to move the object pixel
by pixel.
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4.5 Using the Menu Bar

The menu bar contains the following menus:

Hauptmenuleiste.bmp

Fig. 4-5: Main menu bar

• File: Contains options that enable you to create, open, close, save and
print application projects and files. Additionally, here you can close the
WinStudio development environment.

• Edit: Contains options that enable you to edit your screens and confi-
guration sheets by cutting, copying, pasting, formatting and setting
security levels. You can also undo edits, delete, search and replace
objects.

• View: Contains options that enable you to manage, which toolbars are
visible in the development environment. This menu also provides
"Shortcuts" to the elements and dialog boxes you open most
frequently. Here you can customize your toolbars, restore the default
settings, open the object library, set the zoom and call up the screen
attributes.

• Insert: Contains options that enables you to create and configure a
variety of elements such as tags, classes, documents, drivers, users,
security settings, screens, and ActiveX objects.

• Project: Contains options to execute applications locally or remotely
and provides links used to configure the default settings.

• Tools: Contains options that provide links to auxiliary tools.

• Window: Contains options that enable you to open displays and confi-
guration sheets or set them to the foreground.

• Help: Contains options to enable the access to the help file and further
information about WinStudio.

Note:

• The menu bar is dockable.

• If you click on the menu bar with the right mouse button, a
pop-up menu opens allowing to restore the default settings
of the menu bars and toolbars.

• You also can use this pop-up menu to hide toolbars. Thus,
the development environment can be customized
according to your individual requirements.
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4.6 Using the Toolbars

WinStudio provides several toolbars containing icons that enable you to
make different settings to initiate actions within the program. This section
describes the functions and default location of each toolbar.

Note: All toolbars are dockable screen objects. You can move a
toolbar to any different screen location.

The following toolbars contain general-purpose tools, and are located on
the top of the workspaces, just below the menu bar:

• Standard toolbar: Allows you to perform general actions, such as file
management and printing functions.

Werkzeugleiste_Standard.bmp

Fig. 4-6: Standard toolbar

• Tag Properties toolbar: Allows you to create, locate, and access
different tags and their properties.

Werkzeugleiste_Variablen-Eigenschaften.bmp

Fig. 4-7: Tag Properties toolbar

• Execution Control toolbar: Allows you to control the start and stop of
an application. This applies for local and remote workstations.

Werkzeugleiste_Ausführungsplattform.bmp

Fig. 4-8: Execution Control toolbar

• Web toolbar: Allows you to open web files (HTML).

Werkzeugleiste_Web.bmp

Fig. 4-9: Web toolbar
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• Align and Distribute toolbar: Allows you to arrange objects in the
screens.

Werkzeugleiste_Ausrichten_und_Anordnen.bmp

Fig. 4-10: Align and Distribute toolbar

The following toolbars contain tools to edit objects in screens. If the
default settings are applied, these toolbars are located at the right side of
the interface window, and are only enabled while you are editing a screen:

• Mode toolbar: Here you can set the default values for the screens.

Werkzeugleiste_Modus.bmp

Fig. 4-11: Mode toolbar

• Bitmap toolbar: Allows you to access the bitmap screen editor tools.
This toolbar is only available, when the attribute "Background Picture
layer" is active.

Werkzeugleiste_Bitmap.bmp

Fig. 4-12: Bitmap toolbar

Note: The Bitmap toolbar is hidden by default.

• Static Objects toolbar: Allows you to create graphic objects like
polygons, rectangles, lines and other objects for your screen.

Werkzeugleiste_Statische_Objekte.bmp

Fig. 4-13: Static Objects toolbar

• Dynamic Properties toolbar: Allows you to apply dynamic properties
to the static objects and thus, create animations. This properties
enable you to modify object properties on the fly. Some objects also
enable you to execute commands or insert parameters to the tags.

Werkzeugleiste_Dynamische_Eigenschaften.bmp

Fig. 4-14: Dynamic Properties toolbar
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• Active Objects toolbar: Allows you to create and edit dynamic objects.
Dynamic objects require more parameters than static objects and
provide embedded properties.

Werkzeugleiste_Aktive_Objekte.bmp

Fig. 4-15: Active Objects toolbar

4.7 Workspace

The WinStudio workspace window is an user-friendly interface that
enables you to access quickly to all components (tags, screens,
configuration sheets, etc.) of an application. Application components are
organized in a tree-view divided up in groups with further icons. You can
move, resize, or hide the Workspace window.

WinStudio_Fenster_Arbeitsbereich.bmp

Fig. 4-16: WinStudio Workspace window

Note: The contents of the register button depends on the selected
license model!
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The workspace window is divided into four tabs:

• Database tab: Provides access to all tags of an application and the
security system components. This tab contains the following folders:

• Application Tags

• Classes

• Shared Database

• Internal Tags

• Security

• Graphics tab: Provides access to all screens and icons in the
application. This tab contains the following folders and icons:

• Screens

• Group Screen

• Web Pages

• Library

• Symbols

• Tasks tab: Provides access to all configuration sheets in the
application. This tab contains the following folders:

• Alarms

• Trends

• Recipes

• Reports

• ODBC

• Math (mathematic scripts)

• Scheduler (sequential function chart)

• Comm tab: Provides access to all configuration sheets in the
communication. This tab contains the following folders:

• Driver

• OPC

• TCP/IP

• DDE

Note: By clicking on the folders you can open a context menu
relating to that folder.

4.8 Working with Tags

This chapter provides the information needed to create and edit tags,
including:

• Naming tags and tag fields: Explains the required syntax for tag
names and tag fields.

• Working with tag folders: Explains the purpose of tag folders.

• Tag types: Describes the different tag types.

• Using array tags: Explains how to use array tags (tag fields).

• Using indirect tags: Explains how to use indirect tags (pointer).
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4.9 Naming Tags and Tag Fields

This section contains guidelines for naming tags (identification of tags in
the database) and tag fields (a set of parameters assigned to every tag in
the database). Applications use tag fields during runtime.

Tag Syntax
When naming a tag you must observe the following syntax guidelines:

• Use letters, numbers, and the underscore ( _ ) character.

• Do not use the following characters:

• ` ~ ! @ # $ % ^ & * ( ) - = \ + \ [ ] { } < > ?

• Variable names must begin with a letter.

• Maximum tag length is 255 characters. Maximum class member
length is 255 characters.

• Tag names must be unique. Do not specify the same name for two
different tags.

• WinStudio is not case-sensitive; no distinction is made between upper
case and lower case. For better readability, however, we recommend
to use upper case characters. For example, use BlinkFast instead of
blinkfast.

• Tag names must be different form internal tag or function names.

• Examples for valid tag names:

• Temperature

• Pressure1

• count

• x

Tag Field Syntax
You can use the Tag Properties dialog (open this dialog by clicking on
the Tag Properties icon  in the toolbar) to specify field parameters of a
tag. Use the following syntax to access a tag field:

<TagName>-><TagField> (for example, second->Max)
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You can access the following tag fields during runtime:

Tag type associated with field

Field name
Description of value associated with
each field

Boolean Integer Real String

R=Read only
RW=Read/
Write

Description Description of tag configured in the tags
database

X X X X RW

Max Maximum value that can be written to the
tag at runtime

– X X – RW

Min Minimum value that can be written to the
tag at runtime

– X X – RW

Quality Tag quality (192=GOOD; 0=BAD).
Is updated every time the tag receives a
new value from an expression or a
communication (driver or OPC).
Invalid expressions (such as division by 0)
or reading communication errors set the
quality to BAD.

X X X X R

Size Array seize. If the tag is not an array tag,
the value is returned.

X X X X R

TimeStamp Records time and date, when a tag changes
value

X X X X R

Unit Brief description or measurement unit (max.
9 characters) (such as Kg)

X X X X RW

AlrStatus Status (Integer value) of any currently active
alarm associated with this tag. Each bit
indicates a specific status:
Bit 0 (LSB): HiHi alarm active
Bit 1: Hi alarm active
Bit 2: Lo alarm active
Bit 3: LoLo alarm active
Bit 4: Rate alarm active
Bit 5: 'Deviation+' alarm active
Bit 6: 'Deviation-' alarm active
For example:
Tag->AlrStatus = 2, "Hi" alarm is active.
Tag->AlrStatus = 3, "HiHi" and "Hi" alarms
are active simultaneously.
Tag->AlrStatus = 0, there are no active
alarms
For Boolean tags only 1 (bit 1), 4 (bit 2) or
16 (bit 4) values are returned.

X X X – R

B0 … B31 Value (0 or 1) of any of the 32 bits (b0, b1,
b2, … b31) of an integer tag (B0: LSB B31:
MSB).

– X – – RW

Ack Specifies whether alarms associated with a
tag require acknowledgement:
- 0: Alarms do not require
acknowledgement
- 1: At least one alarm requires
acknowledgement

X X X – RW

AlrDisable Specifies whether alarms associated with a
tag will be enabled or not:

- 0: Alarms are enabled.
- 1: Alarms are disabled. Even if the alarm
condition occurs, the alarm will not become
active.

X X X – RW

HiHi -0, HiHi alarm is inactive.
- I1, HiHi alarm is active.

– X X – R
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Hi - 0, Hi alarm is inactive.
- I1, Hi alarm is active.

X X X – R

Lo - 0, Lo alarm is inactive.
- 1, Lo alarm is active.

X X X – R

LoLo - 0, LoLo alarm is inactive.
- 1, LoLo alarm is active.

– X X – R

Rate - 0, Rate alarm is inactive.
- 1, Rate alarm is active.

X X X – R

Devp - 0, 'Dev+' alarm is inactive.
- 1, 'Dev+' alarm is active.

– X X – R

Devm - 0, 'Dev-' alarm is inactive.
- 1, 'Dev-' alarm is active.

– X X – R

HiHiLimit Limit value for HiHi alarm. – X X – RW

HiLimit Limit value for Hi alarm. – X X – RW

LoLimit Limit value for Lo alarm. – X X – RW

LoLoLimit Limit value for LoLo alarm. – X X – RW

RateLimit Limit value for Rate alarm. – X X – RW

DevSetpoint Set point value for Deviation alarms. – X X – RW

DevpLimit Limit value for 'Deviation+' alarm. – X X – RW

DevmLimit Limit value for 'Deviation-' alarm. – X X – RW

Fig. 4-17: Tag fields

Note: If an application tries to write a value outside the range
specified in the Min and Max fields, the tag database will not
accept the new value and sends a warning to the LogWin. If
the fields Min and Max are set to 0, any value can be written
to the tag.

Caution: You cannot use field designations (e. g. value->MAX) to
configure alarm or trend configuration sheets.
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4.10 Working with Tag Folders

You can use tags to communicate with a field device such as PLCs, to
record calculation results, to monitor alarm conditions, etc. In WinStudio
all tags are organized in folders via the Database tab. The organization of
the folders depends on the origin of the tags (application, internal or
"shared"). WinStudio also provides a folder for compound data structure
classes.

• Application tags: User-defined tags created for screens, to read and
write to field devices, for control, auxiliary tags to execute mathematic
calculations, etc.

• Internal tags: Tags predefined by WinStudio. Internal tags have a
predefined signification and contents (such as time, date,
acknowledge alarms, storage of the logged-on user name or groups,
etc.). This tags cannot be deleted or modified, but can be used in
WinStudio at any place.

• Shared tags: Tags created and used by certain PC-based control
systems. They can be imported into the WinStudio environment.
These tags cannot be edited in WinStudio. However, it is possible to
modify tags in the respective control system and re-import them into
the WinStudio database. The tags can then be used for any WinStudio
task.

• Classes: These structures contain a set of tags instead of one single
value. Classes are created by grouping tags. The tags of a data
structure are called members. Die maximum number of tags within a
structure depends on the license model for WinStudio.

4.11 Tag Types

A tag can be one of the following types:

Boolean: Boolean or digital tag (0 or 1).

Integer: Integer number (positive, negative, or zero), equivalent to C-
type long integer (4 bytes)". For example: 0, 5, -200.

Real: Real number (floating) internally stored as double word, equivalent
to C-type double 8 bytes, for example: 2.12, -10.5).

String: Character string up to 256 characters containing letters,
numbers, or special characters. For example: Recipe product X123,
01/01/90, *** On ***.

Class: User-defined, compound tag.

Fig. 4-18: Tag types

The preceding icons and the corresponding tag types are located in the
Database tab.
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4.12 Using Array Tags

WinStudio tags can consist of a single value or an array of values.

An array tag is a set of tags that all have the same name, but use a
number to differentiate between each tag. This is a matrix with n lines and
a column. The maximum seize of an array depends on the used product
type.

You can use the following syntax:

<ArrayName>[ArrayIndex]

For example: motor[1], motor[2], motor[3], and motor[500].

Caution: During the declaration of the tag you can specify the maximum
number for this array in the Array Seize column. Specify seize
n to indicate that the array tag has positions from 0 to n. 
For example, if the seize of TagA is 3, the tag position could
be: 
TagA[0], TagA[1], TagA[2], and TagA[3].

Using arrays can simplify an application.

For example, if you want to display in a screen of several motors three
special values, you can create a simple screen with three objects by using
3 arrays and an index tag (motor as index containing the current number
of the motor). For example:

Speed[motor], Speed[motor + 1], Motor brake[motor+1].

The used index in the array tag can contain a numerical value or a
mathematic expression with the operator +.

Note: Use operator + only in combination with the following syntax: 
<ArrayTagName>[<NumValue1> + <NumValue2>]
where <NumValue1> and <NumValue2> can contain an
integer tag or a number. 
For example:

Speed[motor+2], Speed[motor+6], or
Speed[Tag A + Tag B]

Using arrays can save a significant amount of development time. For
example, if you want to use conventional tags, the configuration method
is:

• Speed1 Speed of motor  1

• Speed2 Speed of motor  2

• Speed3 Speed of motor  3

• Speed4 Speed of motor  4

Using an array, the task reduces as follows:

Speed[j] Max. speed of motor {j}
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4.13 Using Indirect Tags

WinStudio supports indirect access to tags in the database. For example:
Assume there's a tag X of type string. This tag can contain the name of
another tag available in the database, i. e. this tag can provide a pointer to
any other tag type, including the class type.

The syntax for an indirect tag is:

@<IndirectTagName>

If, for example, tag X contains as content text TEMP, reading and writing
with @X provides the access to the value for the TEMP tag.

Note: Any tag created as a string type is a potential indirect tag
(pointer).
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5 Creating a WinStudio Application

5.1 General Information

This chapter explains how to create an executable WinStudio application
and how to configure the OPC communication.

• Creating a new application: Explains how to create a WinStudio
application.

• Parameterizing the project settings: Explains how to set the
required parameters for the application.

• Creating tags: Explains how to create a new tag and insert it in the
database.

• Creating a start screen (main.scr): Explains how to create the start
screen.

• Creating an animated screen (motor.scr): Explains how to create an
animated screen.

• Configuring the OPC communication: Explains how to set the OPC
Client.

5.2 Creating a New Application

To create a new WinStudio application, proceed as follows:

1. Select File � New in the main menu.

2. If the New dialog window appears, click on the project tab.

Wählen_Sie_das_Register_Projekt_im_Dialogfenster_Neu.bmp

Fig. 5-1: Select the Project tab in dialog window New
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3. Enter the name for your application in the Application Name field (for
this project GetStart).

WinStudio creates automatically a new folder for this application with this
name and sets the start options for this application. To select the path
where you want to save the application enter the path name in the
Location field, or choose the path by clicking on Browse.

4. Choose a platform (product type) from the Target Platform list (for
this project Advanced Server) and confirm with OK.

Note: Primarily, the selection of the product type depends on the
number of the used tags. Use CEView Lite, CEView Standard
or CEView Pro, to create applications for devices using WinCE
as operating system.

5. When the Project Wizard window appears, select there Empty
Application from the Template list, click on the resolution 800 x 600
and then on OK.

Anlegen_einer_leeren_Applikation.bmp

Fig. 5-2: Creating an empty application with a resolution of 640 x 480
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The name of the new application now appears in the Workspace window.

Applikation_im_Fenster_Arbeitsbereich.bmp

Fig. 5-3: Application in the Workspace window

5.3 Parameterizing the Project Settings

Click with the right mouse button on Project: GetStart (or command line:
Project � Settings) and open the dialog window. By filling the single fields
you can enter the parameters of the whole application.

• Use the Identification tab for general specifications to this application
(description, company name, revision status, name of the engineer,
used field devices and supplementary information).

• Use the Option tab to set the following parameters: automatic
language translation, historical alarms, communication drivers.

• Use the Runtime Desktop tab to enable or disable the parameters for
the runtime.

• Use the Web tab for the specifications of an application to be used
with a WebServer: Data Server IP address, send period (in
milliseconds), URL address, tooltips, file compression, logging
parameters and IP security properties.

• Use the Presettings tab, to activate/deactivate the warnings before
downloading the files in the target system.
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You can specify the runtime of the projects in the Runtime Desktop tab.

Spezifikation_des_Startbildes.bmp

Fig. 5-4: Specification of the start screen

Enter in the startup screen field: main (this screen is opened while starting
the application).

5.4 Creating a Tag

You can generate tags anytime while creating an application. All tags are
in the User Tags folder in the Database tab in the Workspace:

Verzeichnis_Anwender-Variablen.bmp

Fig. 5-5: Application tags folder

Note: If the workspace is not visible, you can activate it with
command line  View � Toolbars � Workspace (or ALT+0).
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Proceed as follows to create a new tag:

1. Double-click on the Datasheet View icon to open the configuration
sheet User Tags.

2. To create a new tag you must parameterize the following properties:

Name: Enter a unique name (all tags must have a unique
name).

Array seize: Enter the number of the required elements of an array.
If you skip the input of this field, a simple tag with the
array value 0 is created.

Type: Select the type (Boolean, Integer, Real, String, Class).

Description
(optional):

Enter here for documentation purposes the desired
use of the tag.

Web data: Select the behavior of the tag for a web application
and the communication with a Web Thin Client station.

Select Local, if the tag should not be kept synchronously with tags in the
Web Thin Client station.

Select Server, if the tag should be kept synchronously with tags in the
Web Thin Client station.

3. Now, we will declare a class for our example. Click with the right
mouse button on the Class tab in folder User Tags.

Einfügen_des_Variablen-Typs_Klasse.bmp

Fig. 5-6: Inserting tag type class
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4. Click on Insert Class and then, enter the name of the new class.
Confirm with OK.

Name_der_neuen_Klasse.bmp

Fig. 5-7: Name of the new class

5. Now, enter the single class elements in the tag form and close it.

Erstellen_der_Elemente_der_Klasse_motor.bmp

Fig. 5-8: Creating the elements of class "motor"

6. The Element List of class motor now contains all entered elements.
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7. Then, create a variable of type Class. For this, click with the right
mouse button on Datasheet View in folder Application Tags. Then,
click on Open.

Erstellen_einer_Variablen.bmp

Fig. 5-9: Creating a tag

8. Now, enter tag motor_status  (array with 10 elements of type
class:motor) in the tag form. Extend the tag form by tag cyclecnt (PLC
cycle counter: simple integer tag). Finally, save the form.

Elemente_einer_Variablen.bmp

Fig. 5-10: Elements of a tag

Note: The values of a tag entry are only added to the database, if the
input field is exited.
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5.5 Creating a Start Screen (main.scr)

1. Click in the Workspace window on the Graphics tab and click with
the right mouse button on the Screen folder.

Einfügen_eines_Bildes.bmp

Fig. 5-11: Inserting a screen

2. Click on Insert to set the Screen Attributes. Enter the description of
the screen in the Description field. Seize and Location of the screen
are preset. Confirm with OK.

Erstellen_der_Bildeigenschaften.bmp

Fig. 5-12: Setting the Screen Attributes
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3. A new screen is opened. Click with the right mouse button in the new
screen and select there Background color from the pop-up menu.
Select here gray and apply this color as background color by clicking
on OK.

Fig. 5-13: Setting the background color

4. Create a text object by clicking on the text  icon of the toolbar.

5. Click on the screen and enter the following text:
Welcome to the Rexroth - Demo - Application

6. Double-click on the text to open the Object Properties.

Textobjekt.bmp

Fig. 5-14: Text object

Eigenschaften_des_Objektes_Text.bmp

Fig. 5-15: Properties of the object text

7. Select the check box Transparent to display the text object without
background color.

8. Click on fonts to fix the font type, color and seize.

9. Click on the text object and, while pressing the mouse button, drag it
to the desired position.

Note: Double-clicking on an object always opens the Object
Properties window with the parameters belonging to this
object. The properties depend on the selected object.
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10. Click on the button  icon of the toolbar to create a Button object.

11. Click on the screen and, while pressing the mouse button, drag it in
the desired shape.

12. Click on the Button object and enter the following text:
Click here to open motor screen

Erstellen_eines_Button_Objektes.bmp

Fig. 5-16: Creating a Button object

13. Select the Button object by clicking on it and choose then in the

toolbar the command  icon to assign the dynamic property
COMMAND to this object.

14. Double-click on the Button object to open the object properties. Now,
enter the following instruction in the Expression field: open("motor").

Erstellen_der_Kommando-Eigenschaften_eines_Buttons.bmp

Fig. 5-17: Creating the command property of a button

Note: By opening the drop-down list all object properties become
visible.

If a user presses this button during runtime, in the phase "While pressing"
the screen "motor.scr" is opened. With entry SHIFT + M in the Key field, a
shortcut is assigned to the button.

15. Finally, save the created screen with File � Save; enter main as file
name and Screen files (*.scr) as file type.

16. To close the screen, click with the right mouse button on the screen
and select Close in the pop-up menu.
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5.6 Creating the Screen Motor (motor.scr)

The screen motor.scr is provided to illustrate clearly the properties of
motors. The screen "motor.scr" is created by the following steps:

1. Select the Graphics tab and click with the right mouse button on the
Screen folder.

2. Select Insert from the pop-up menu and the Screen Attributes dialog
appears automatically.

3. Use this dialog to determine all screen attributes, in our case confirm
the presetting by clicking on OK.

4. Select by clicking on the right mouse button Background color in the
new screen, choose gray; and apply the background color with OK.

5. Click on the text  icon, click on the empty space in the screen and
enter there:
Motor screen

6. Double-click on the text object to open the Object Properties
window.

7. Select the check box Transparent to display the text object without
background color.

8. Click on fonts to fix the font type, color and seize.

9. Click on the text object and, while pressing the mouse button, drag it
to the desired position.

Bildtitel_des_Bildes_Motor.bmp

Fig. 5-18: Screen title of the Motor.scr

10. Click on the text  icon to create an identification text for the motor.
Click on an empty space in the screen and enter there:
Motor ID: ####

Note: The character # is provided in WinStudio as wild card
character for a text input and output (Text I/O). The number of
the wild card characters determines the number of the text
characters to be input or output.
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11. Double-click on the text object to open the Object Properties
window.

Aktivierung_Textobjekt.bmp

Fig. 5-19: Activating the text object

12. Click on the Text I/O on/off  icon of the toolbar. Enter the following
tag in the Tag/Expression field of the Text I/O's object properties; you
can write the tag or search it in the database with the tag selection:
Motor_status[0].motor_number

Explanation of tag Motor_status[0].motor_number:

The tag motor_status is declared as tag of type Class:motor with field
seize 10; motor_status[0] is the first array element; the number in the
square brackets is the field index. The element operator (.) refers to the
class element motor_number of the Class:motor.

Erstellen_eines_Text_IO_Objektes.bmp

Fig. 5-20: Creating a text I/O object

13. The Input possible and E-Sign fields of the object properties remain
unselected, format Fmt remains Decimal.
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14. The error status of the motor is to be illustrated in a colored manner in
a library element. For this, select Library folder in the Graphics tab
of the Workspace by double-clicking on it. Now, select motors.

Bibliothek_motors.bmp

Fig. 5-21: Library "motors"

15. Click on the motor element and drag it in your screen while pressing
the mouse button. Close the Library window.

16. Double-click on the motor to open the Object Properties window.

Bibliotheks-Element_motor.bmp

Fig. 5-22: Library element "motor"

17. To illustrate the error status of the motor in a colored manner, assign
a tag via the Tag/Expression field to the Object properties Color:
Motor_status[0].failure

Objekteigenschaften_Farben_des_Bibliotheks-Elementes.bmp

Fig. 5-23: Object properties Color of the library element
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18. Click on the motor element and drag it to the desired position within
the screen.

19. Click on the text  icon, to create the following text:
Brake

20. Double-click on the text object, and select the check box Transparent,
to indicate the text object without a background color.

Bremse.bmp

Fig. 5-24: Brake

21. Click on the ellipse  icon of the toolbar. Click on an empty field in
the screen and, while pressing the mouse button, drag the ellipse to
the desired seize.

Ellipse.bmp

Fig. 5-25: Ellipse

22. Double-click on the ellipse object and open the Object Properties
window.

23. Click on the color  icon of the toolbar and enter the following tag in
the Tag/Expression field:
Motor_status[0].brake

Dialog_Objekt_Einstellungen.bmp

Fig. 5-26: Object properties dialog

24. Select the ellipse object by clicking on it and, while pressing the
mouse button, position it besides the text object Brake.
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25. Position the identification text, the ellipse including text and the library
element for motor according to your requirements. Click on the

rectangle  icon of the toolbar. Click on an empty field besides your
arrangement and, while pressing the mouse button, drag the
rectangle over the elements. Double-click on the rectangle and select
in the pop-up menu In Background to position the rectangle behind
the other objects.

Rechteck_Objekt_im_Hintergrund.bmp

Fig. 5-27: Rectangle: arrange object in the background

26. Click on the selection  icon of the toolbar. Keep the SHIFT key
pressed and click on all objects to be selected (you can rope all
objects while pressing the left mouse button).

Markieren_ausgewählter_Objekte.bmp

Fig. 5-28: Marking selected objects

27. Click in the Align and Distribute toolbar on the group  icon. Group
all selected objects into a group object.
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28. To be able to finish the application, the "shutdown() function" is
assigned to an EXIT symbol. Double-click in the Graphics tab of the
Workspace on the Library folder. Select there under icons the EXIT
icon and, while pressing the mouse button, drag it into the screen.

EXIT_Symbol.bmp

Fig. 5-29: EXIT icon

29. Close the Library window and double-click on the EXIT object.

EXIT_Objekt.bmp

Fig. 5-30: EXIT object

30. Click on the command  icon of the toolbar. Now, enter the
following instruction in the Expression field:
shutdown()

Kommando_shutdown.bmp

Fig. 5-31: Command shutdown()

31. Finally, save the created screen with File � Save; enter motor as file
name and Screen files (*.scr) as file type.

32. To close the screen, click with the right mouse button on the screen
and select Close in the pop-up menu.
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5.7 Realizing a Process Connection

The connection of the PLC control tags to the visualization occurs by the
OPC communication. WinStudio has created driver sheets for this
communication.

1. Double-click in the Comm tab of the Workspace on the OPC folder.
Then, click on Insert.

Einfügen_eines_OPC_Treiberblattes.bmp

Fig. 5-32: Inserting an OPC driver sheet

2. The OPC driver sheet is opened. Enter in the Description field a
description of this driver sheet.

3. Select the used OPC server in the Server Selection field.

Note: For this example the control Rexroth IndraLogic L40 was
used. This PLC uses the OPC server IndraLogic.OPC.02.

4. Enter 200 ms for the reading clock in the Update Rate field.

5. Double-click in the Tag name field. The tag selection indicates all
visualization tags. Our example requires the tag motor_status.
Confirm the tag with OK.
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6. Click with the right mouse button in the Element field. Select OPC
Browser from the pop-up menu. A list of all OPC elements managed
by the OPC server appears.

OPC_Treiberblatt.bmp

Fig. 5-33: OPC driver sheet

Note: If an empty element list is illustrated after activating the OPC
browser, the OPC configuration and the symbol download into
the control must be verified.
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7. Fill in the OPC driver sheet according to the example requirements;
enter the following visualization tags with corresponding process
connection into the driver sheet:

Motor_status[0].motor_number � PLC_PRG:motor_1.motor_number

Motor_status[0].brake � PLC_PRG:motor_1.brake

Motor_status[0].failure � PLC_PRG:motor_1.failure

Note: The names of the PLC control tags can be different in your
PLC project; however, they are in any case provided for use in
the OPC browser.

Ausgefülltes_OPC_Treiberblatt.bmp

Fig. 5-34: Filled OPC driver sheet

8. Finally, you finish the establishment of the process connection by File
� Save as; for this, in the dialog box Sheet number 1 is indicated.
Apply this value with OK. Now, you have created the driver sheet
OPCCL001.OPC.

Sichern_eines_OPC_Treiberblattes.bmp

Fig. 5-35: Save the OPC driver sheet
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5.8 Test of the Application

At last, the application is tested.

1. Verify in Project � Status, if all required execution tasks
(Background Task, OPC Client Runtime, Viewer) are automatically
started.

Dialog_Projekt_Status.bmp

Fig. 5-36: Dialog: Project Properties � Status

Note: In Project � Status you can decide which tasks are
automatically or manually launched, when the visualization is
started. The management of the startup can be modified by
activating the Startup button.

2. Click in the Execution Environment toolbar on the Start Application

 icon.

3. The application is started with the set start screen "main".
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6 Running the Web-Based Application

6.1 General Information

This chapter explains how to prepare your application to run it via the web
functions.

6.2 Instruction to Run a Web-Based Application

To enable the application tags to be used on the web, follow the
instruction below.

1. Open the application tags database and specify the "Server" option
instead of "Local" in the "Web data" column for all tags, that must
exchange data between the Server station and the Web Thin Client
station.

Datenbank_der_Applikationsvariablen.bmp

Fig. 6-1: Application tag database

Note: WinStudio stores all application screens in the Screens folder
located in the Graphics tab in the Workspace.
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To open your Screen folder, proceed as follows:

1. Expand the Screen folder by clicking on the plus sign and double-
click on main.scr.

Auswahl_des_Bildes_main.bmp

Fig. 6-2: Select main.scr.

2. Select File → Save as HTML to save the screen in HTML format.

Speichern_des_Bildes_im_HTML_Format.bmp

Fig. 6-3: Saving screens in HTML format
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3. After executing this command, the screen is stored in the Web
subfolder of the application directory.

Ansicht_der_Web_Dateien.bmp

Fig. 6-4: Viewing web data

4. Select "Project" � "Status" from the main menu and click on
"Startup Mode" "Automatic" for "TCP/IP Server".

5. Select Project −> Settings in the main menu and click on the Web
tab.

6. Now, you must specify the IP address of the server station. The
server station is the device, on which you want to run WinStudio or
CeView runtime with this application. Enter this address in the Data
Server / IP Address field. The Web Thin Client station exchanges
online the tag values specified in this field with the station.
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7. You also must specify the "URL path" of the web data (in subfolder
Web) in the URL field. The URL depends on the home directory
configured for your Web Server station.
If the subfolder Web of the application is the home directory, you can
take over the following specifications:

Spezifikation_in_den_Projekteinstellungen.bmp

Fig. 6-5: Specifying the project settings

Note: Microsoft provides Web Server for all Microsoft operating
systems. Consult your Microsoft documentation for information
about installing and configuring a Web Server.

8. After configuring the Web parameters, click on OK to close the
Project Settings dialog.

9. Close all screens in your screen editor (File -> Close All) and then
select Tools → Verify Application to update the Web settings for the
Web pages with the parameters.

Caution: You must always execute the command Tools → Verify
Application after having changed a parameter in the Project
Settings.
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To test your web-based application, proceed as follows:

1. Click on the Run Application  icon in the WinStudio toolbar to start
the application locally on the server station.

2. Open an Internet browser (Microsoft Internet Explorer or Netscape)
and enter there the URL address to open the main.html screen on
the server station (for example: http://127.0.0.1/main.html).

3. When the Log On dialog appears in the browser (see the following
figure), enter "guest" in the User Name field and click on Ok to open
the "main.html" dialog in the browser.

Einloggen_als_Guest.bmp

Fig. 6-6: Logging on as guest

Note: The Web Thin Client requires for the animation an ActiveX
component (ISSymbol.ocx). If you have Internet connection,
this component is downloaded and registered automatically. 
Otherwise, you must copy the "ISSymbol.cab" file from the
WinStudio's BIN subfolder and paste it into the
\<OSPath>\System32 directory on the Web Thin Client
station. Use WinZip® to unzip (extract) the file into this
directory. After that, you have to register the file
ISSymbol.ocx with command regsvr32 ISSymbol.ocx.
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7 Running Applications from a Remote Station

7.1 General Information

This chapter explains how to run your application from a remote station.

After configuring an application and testing it locally on the development
workstation, you can download it to the remote target workstation. This is
possible, if one of the following versions is installed on the target
workstation: WinStudio in Windows NT/2000/XP or CEView in
Windows CE.

7.2 Instructions to Run an Application from a Remote Station

1. From your remote target workstation select Start →→→→ Program Files →→→→
Rexroth →→→→ WinStudio →→→→ WinStudio →→→→ Remote Agent and verify,
that the "Remote Agent" (CEServer.exe) is running.

2. If the following window appears, click on the Setup button.

Überprüfen_des_Remote_Agent.bmp

Fig. 7-1: Verifying the remote agent
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3. Now, select Serial Port or TCP/IP depending on the existing
communication and specify the necessary serial port.

Spezifikation_der_Kommunikation.bmp

Fig. 7-2: Specifying the communication

Note: WinStudio recommends using TCP/IP for performance
reasons.

4. Click on OK and keep the remote agent running on this station.

5. Select Project →  Execution Environment from the main menu of
your development workstation to open the following window:

Spezifikation_der_Parameter.bmp

Fig. 7-3: Specifying the parameters

6. Select here also the communication type in the target workstation
(Network IP or Serial Port). If necessary, enter the IP address of
your remote station.



WinStudio Running Applications from a Remote Station 7-3

DOK-CONTRL-WIS*PC**V06-KB01-EN-P           

7. Click on the Connect button to connect to the remote station.

Note: If the remote station is a CE device, click on the Install
System Files button. System Files to transmit the runtime
modules to the CE device.

8. Return to the Execution Environment dialog and select the
Application tab. Click on the Send to Target button to download the
application to the remote station.

After transmitting all files start the application by clicking on Run.
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10 Service & Support

10.1 Helpdesk

Unser Kundendienst-Helpdesk im Hauptwerk Lohr
am Main steht Ihnen mit Rat und Tat zur Seite.
Sie erreichen uns

Our service helpdesk at our headquarters in Lohr am
Main, Germany can assist you in all kinds of inquiries.
Contact us

- telefonisch - by phone: +49 (0) 9352 40 50 60
über Service Call Entry Center Mo-Fr   07:00-18:00
- via Service Call Entry Center Mo-Fr 7:00 am - 6:00 pm

- per Fax - by fax: +49 (0) 9352 40 49 41

- per e-Mail - by e-mail: service.svc@boschrexroth.de

10.2 Service-Hotline

Außerhalb der Helpdesk-Zeiten ist der Service
direkt ansprechbar unter

After helpdesk hours, contact our service
department directly at

+49 (0) 171 333 88 26

oder - or +49 (0) 172 660 04 06

10.3 Internet

Unter www.boschrexroth.com finden Sie
ergänzende Hinweise zu Service, Reparatur und
Training sowie die aktuellen Adressen *) unserer
auf den folgenden Seiten aufgeführten Vertriebs-
und Servicebüros.

Verkaufsniederlassungen

Niederlassungen mit Kundendienst

Außerhalb Deutschlands nehmen Sie bitte zuerst Kontakt mit
unserem für Sie nächstgelegenen Ansprechpartner auf.

*) Die Angaben in der vorliegenden Dokumentation können
seit Drucklegung überholt sein.

At www.boschrexroth.com you may find
additional notes about service, repairs and training
in the Internet, as well as the actual addresses *)
of our sales- and service facilities figuring on the
following pages.

sales agencies

offices providing service

Please contact our sales / service office in your area first.

*) Data in the present documentation may have become
obsolete since printing.

10.4 Vor der Kontaktaufnahme... - Before contacting us...

Wir können Ihnen schnell und effizient helfen wenn
Sie folgende Informationen bereithalten:

1. detaillierte Beschreibung der Störung und der
Umstände.

2. Angaben auf dem Typenschild der
betreffenden Produkte, insbesondere
Typenschlüssel und Seriennummern.

3. Tel.-/Faxnummern und e-Mail-Adresse, unter
denen Sie für Rückfragen zu erreichen sind.

For quick and efficient help, please have the
following information ready:

1. Detailed description of the failure and
circumstances.

2. Information on the type plate of the affected
products, especially type codes and serial
numbers.

3. Your phone/fax numbers and e-mail address,
so we can contact you in case of questions.
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10.5 Kundenbetreuungsstellen - Sales & Service Facilities

Deutschland – Germany vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Vertriebsgebiet Mitte
 Germany Centre

Rexroth Indramat GmbH
Bgm.-Dr.-Nebel-Str. 2 / Postf. 1357
97816 Lohr am Main / 97803 Lohr

Kompetenz-Zentrum Europa

Tel.: +49 (0)9352 40-0
Fax: +49 (0)9352 40-4885

S E R V I C E  A U T O M A T I O N

C A L L  E N T R Y  C E N T E R
H e l p d e s k
MO – FR

von 07:00 - 18:00 Uhr
from 7 am – 6 pm

Tel. +49 (0) 9352 40 50 60
Fax +49 (0) 9352 40 49 41

service.svc@boschrexroth.de

S E R V I C E  A U T O M A T I O N

HO T L INE  24  /  7  /  3 6 5

außerhalb der Helpdesk-Zeit
out of helpdesk hours

Tel.: +49 (0)172 660 04 06
o d e r  /  o r

Tel.: +49 (0)171 333 88 26

S E R V I C E  A U T O M A T I O N

ERSATZTEILE / SPARES
verlängerte Ansprechzeit
- extended office time -

♦ nur an Werktagen
- only on working days -

♦ von 07:00 - 18:00 Uhr
- from 7 am - 6 pm  -

Tel. +49 (0) 9352 40 42 22

Vertriebsgebiet Süd
 Germany South

Bosch Rexroth AG
Landshuter Allee 8-10
80637 München

Tel.: +49 (0)89 127 14-0
Fax: +49 (0)89 127 14-490

Vertriebsgebiet West
 Germany West

Bosch Rexroth AG
Regionalzentrum West
Borsigstrasse 15
40880 Ratingen

Tel.: +49 (0)2102 409-0
Fax: +49 (0)2102 409-406

+49 (0)2102 409-430

Gebiet Südwest
 Germany South-West

Bosch Rexroth AG
Service-Regionalzentrum Süd-West
Siemensstr. 1
70736 Fellbach

Tel.: +49 (0)711 51046–0
Fax: +49 (0)711 51046–248

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Walsroder Str. 93
30853 Langenhagen

Tel.: +49 (0) 511 72 66 57-0
Service: +49 (0) 511 72 66 57-256
Fax: +49 (0) 511 72 66 57-93
Service: +49 (0) 511 72 66 57-783

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Regionalzentrum Mitte
Waldecker Straße 13
64546 Mörfelden-Walldorf

Tel.: +49 (0) 61 05 702-3
Fax: +49 (0) 61 05 702-444

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Beckerstraße 31
09120 Chemnitz

Tel.: +49 (0)371 35 55-0
Fax: +49 (0)371 35 55-333

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Regionalzentrum Ost
Walter-Köhn-Str. 4d
04356 Leipzig

Tel.: +49 (0)341 25 61-0
Fax: +49 (0)341 25 61-111
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Europa (West) - Europe (West)

vom Ausland: (0) nach Landeskennziffer weglassen, Italien: 0 nach Landeskennziffer mitwählen
from abroad:    don’t dial (0) after country code, Italy:    dial 0 after country code

Austria - Österreich

Bosch Rexroth GmbH
Electric Drives & Controls
Stachegasse 13
1120 Wien

Tel.: +43 (0)1 985 25 40
Fax: +43 (0)1 985 25 40-93

Austria – Österreich

Bosch Rexroth GmbH
Electric Drives & Controls
Industriepark 18
4061 Pasching

Tel.: +43 (0)7221 605-0
Fax: +43 (0)7221 605-21

Belgium - Belgien

Bosch Rexroth NV/SA
Henri Genessestraat 1
1070 Bruxelles

Tel: +32 (0) 2 451 26 08
Fax: +32 (0) 2 451 27 90
 info@boschrexroth.be
 service@boschrexroth.be

Denmark - Dänemark

BEC A/S
Zinkvej 6
8900 Randers

Tel.: +45 (0)87 11 90 60
Fax: +45 (0)87 11 90 61

Great Britain – Großbritannien

Bosch Rexroth Ltd.
Electric Drives & Controls
Broadway Lane, South Cerney
Cirencester, Glos GL7 5UH

Tel.: +44 (0)1285 863000
Fax: +44 (0)1285 863030
 sales@boschrexroth.co.uk
 service@boschrexroth.co.uk

Finland - Finnland

Bosch Rexroth Oy
Electric Drives & Controls
Ansatie 6
017 40 Vantaa

Tel.: +358 (0)9 84 91-11
Fax: +358 (0)9 84 91-13 60

France - Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
Avenue de la Trentaine
(BP. 74)
77503 Chelles Cedex

Tel.: +33 (0)164 72-63 22
Fax: +33 (0)164 72-63 20
Hotline: +33 (0)608 33 43 28

France - Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
ZI de Thibaud, 20 bd. Thibaud
(BP. 1751)
31084 Toulouse

Tel.: +33 (0)5 61 43 61 87
Fax: +33 (0)5 61 43 94 12

France – Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
91, Bd. Irène Joliot-Curie
69634 Vénissieux – Cedex
Tel.: +33 (0)4 78 78 53 65
Fax: +33 (0)4 78 78 53 62

Italy - Italien

Bosch Rexroth S.p.A.
Via G. Di Vittorio, 1
20063 Cernusco S/N.MI
Hotline: +39 02 92 365 563
Tel.: +39 02 92 365 1
Service: +39 02 92 365 300
Fax: +39 02 92 365 500
Service: +39 02 92 365 516

Italy - Italien

Bosch Rexroth S.p.A.
Via Paolo Veronesi, 250
10148 Torino

Tel.: +39 011 224 88 11
Fax: +39 011 224 88 30

Italy - Italien

Bosch Rexroth S.p.A.
Via Mascia, 1
80053 Castellamare di Stabia NA

Tel.: +39 081 8 71 57 00
Fax: +39 081 8 71 68 85

Italy - Italien

Bosch Rexroth S.p.A.
Via del Progresso, 16 (Zona Ind.)
35020 Padova

Tel.: +39 049 8 70 13 70
Fax: +39 049 8 70 13 77

Italy - Italien

Bosch Rexroth S.p.A.
Via Isonzo, 61
40033 Casalecchio di Reno (Bo)

Tel.: +39 051 29 86 430
Fax: +39 051 29 86 490

Netherlands - Niederlande/Holland

Bosch Rexroth Services B.V.
Technical Services
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0) 411 65 19 51
Fax: +31 (0) 411 67 78 14
Hotline: +31 (0) 411 65 19 51
services@boschrexroth.nl

Netherlands – Niederlande/Holland

Bosch Rexroth B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel

Tel.: +31 (0) 411 65 16 40
Fax: +31 (0) 411 65 14 83
 www.boschrexroth.nl

Norway - Norwegen

Bosch Rexroth AS
Electric Drives & Controls
Berghagan 1          or: Box 3007
1405 Ski-Langhus     1402 Ski
Tel.: +47 (0) 64 86 41 00

Fax: +47 (0) 64 86 90 62

Hotline: +47 (0)64 86 94 82
 jul.ruud@rexroth.no

Spain - Spanien

Bosch Rexroth S.A.
Electric Drives & Controls
Centro Industrial Santiga
Obradors s/n
08130 Santa Perpetua de Mogoda
Barcelona

Tel.: +34 9 37 47 94 00
Fax: +34 9 37 47 94 01

Spain – Spanien

Goimendi S.A.
Electric Drives & Controls
Parque Empresarial Zuatzu
C/ Francisco Grandmontagne no.2
20018 San Sebastian

Tel.: +34 9 43 31 84 21
- service: +34 9 43 31 84 56
Fax: +34 9 43 31 84 27
- service: +34 9 43 31 84 60
 sat.indramat@goimendi.es

Sweden - Schweden

Bosch Rexroth AB
Electric Drives & Controls
- Varuvägen 7
(Service: Konsumentvägen 4, Älfsjö)
125 81 Stockholm

Tel.: +46 (0)8 727 92 00
Fax: +46 (0)8 647 32 77

Sweden - Schweden

Bosch Rexroth AB
Electric Drives & Controls
Ekvändan 7
254 67 Helsingborg
Tel.: +46 (0) 42 38 88 -50
Fax: +46 (0) 42 38 88 -74

Switzerland East - Schweiz Ost

Bosch Rexroth Schweiz AG
Electric Drives & Controls
Hemrietstrasse 2
8863 Buttikon
Tel. +41 (0) 55 46 46 111
Fax +41 (0) 55 46 46 222

Switzerland West - Schweiz West

Bosch Rexroth Suisse SA
Av. Général Guisan 26
1800 Vevey 1

Tel.: +41 (0)21 632 84 20
Fax: +41 (0)21 632 84 21
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Europa (Ost) - Europe (East)

vom Ausland: (0) nach Landeskennziffer weglassen  
from abroad:    don’t dial (0) after country code

Czech Republic - Tschechien

Bosch -Rexroth, spol.s.r.o.
Hviezdoslavova 5
627 00 Brno

Tel.: +420 (0)5 48 126 358
Fax: +420 (0)5 48 126 112

Czech Republic - Tschechien

DEL a.s.
Strojírenská 38
591 01 Zdar nad Sázavou
Tel.: +420 566 64 3144
Fax: +420 566 62 1657

Hungary - Ungarn

Bosch Rexroth Kft.
Angol utca 34
1149 Budapest

Tel.: +36 (1) 422 3200
Fax: +36 (1) 422 3201

Poland – Polen

Bosch Rexroth Sp.zo.o.
ul. Staszica 1
05-800 Pruszków

Tel.: +48 22 738 18 00
– service: +48 22 738 18 46
Fax: +48 22 758 87 35
– service: +48 22 738 18 42

Poland – Polen

Bosch Rexroth Sp.zo.o.
Biuro Poznan
ul. Dabrowskiego 81/85
60-529 Poznan

Tel.: +48 061 847 64 62 /-63
Fax: +48 061 847 64 02

Romania - Rumänien

East Electric S.R.L.
Bdul Basarabia no.250, sector 3
73429 Bucuresti

Tel./Fax:: +40 (0)21 255 35 07
+40 (0)21 255 77 13

Fax: +40 (0)21 725 61 21
 eastel@rdsnet.ro

Romania - Rumänien

Bosch Rexroth Sp.zo.o.
Str. Drobety nr. 4-10, app. 14
70258 Bucuresti, Sector 2

Tel.: +40 (0)1 210 48 25
+40 (0)1 210 29 50

Fax: +40 (0)1 210 29 52

Russia - Russland

Bosch Rexroth OOO
Wjatskaja ul. 27/15
127015 Moskau

Tel.: +7-095-785 74 78
+7-095 785 74 79

Fax: +7 095 785 74 77
 laura.kanina@boschrexroth.ru

Russia Belarus - Weissrussland

ELMIS
10, Internationalnaya
246640 Gomel, Belarus
Tel.: +375/ 232 53 42 70

+375/ 232 53 21 69
Fax: +375/ 232 53 37 69
 elmis_ltd@yahoo.com

Turkey - Türkei

Bosch Rexroth Otomasyon
San & Tic. A..S.
Fevzi Cakmak Cad No. 3
34630 Sefaköy Istanbul

Tel.:  +90 212 413 34 00
Fax:  +90 212 413 34 17
 www.boschrexroth.com.tr

Turkey - Türkei

Servo Kontrol Ltd. Sti.
Perpa Ticaret Merkezi B Blok
Kat: 11 No: 1609
80270 Okmeydani-Istanbul

Tel: +90 212 320 30 80
Fax: +90 212 320 30 81
 remzi.sali@servokontrol.com
 www.servokontrol.com

Slowenia - Slowenien

DOMEL
Otoki 21
64 228 Zelezniki

Tel.: +386 5 5117 152
Fax: +386 5 5117 225
 brane.ozebek@domel.si
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Africa, Asia, Australia – incl. Pacific Rim

Australia - Australien

AIMS - Australian Industrial
Machinery Services Pty. Ltd.
28 Westside Drive
Laverton North Vic 3026
Melbourne

Tel.: +61 3 93 14 3321
Fax: +61 3 93 14 3329
Hotlines: +61 3 93 14 3321

+61 4 19 369 195
 enquires@aimservices.com.au

Australia - Australien

Bosch Rexroth Pty. Ltd.
No. 7, Endeavour Way
Braeside Victoria, 31 95
Melbourne

Tel.: +61 3 95 80 39 33
Fax: +61 3 95 80 17 33
 mel@rexroth.com.au

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
Waigaoqiao, Free Trade Zone
No.122, Fu Te Dong Yi Road
Shanghai 200131 - P.R.China

Tel.: +86 21 58 66 30 30
Fax: +86 21 58 66 55 23
richard.yang_sh@boschrexroth.com.cn
gf.zhu_sh@boschrexroth.com.cn

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
4/f, Marine Tower
No.1, Pudong Avenue
Shanghai 200120 - P.R.China

Tel: +86 21 68 86 15 88
Fax: +86 21 58 40 65 77

China

Bosch Rexroth China Ltd.
15/F China World Trade Center
1, Jianguomenwai Avenue
Beijing 100004, P.R.China

Tel.: +86 10 65 05 03 80
Fax: +86 10 65 05 03 79

China

Bosch Rexroth China Ltd.
Guangzhou Repres. Office
Room 1014-1016, Metro Plaza,
Tian He District, 183 Tian He Bei Rd
Guangzhou 510075, P.R.China

Tel.: +86 20 8755-0030
+86 20 8755-0011

Fax: +86 20 8755-2387

China

Bosch Rexroth (China) Ltd.
A-5F., 123 Lian Shan Street
Sha He Kou District
Dalian 116 023, P.R.China

Tel.: +86 411 46 78 930
Fax: +86 411 46 78 932

China

Melchers GmbH
BRC-SE, Tightening & Press-fit
13 Floor Est Ocean Centre
No.588 Yanan Rd. East
65 Yanan Rd. West
Shanghai 200001

Tel.: +86 21 6352 8848
Fax: +86 21 6351 3138

Hongkong

Bosch Rexroth (China) Ltd.
6th Floor,
Yeung Yiu Chung No.6 Ind Bldg.
19 Cheung Shun Street
Cheung Sha Wan,
Kowloon, Hongkong

Tel.: +852 22 62 51 00
Fax: +852 27 41 33 44

alexis.siu@boschrexroth.com.hk

India - Indien

Bosch Rexroth (India) Ltd.
Electric Drives & Controls
Plot. No.96, Phase III
Peenya Industrial Area
Bangalore – 560058

Tel.: +91 80 51 17 0-211...-218
Fax: +91 80 83 94 345

+91 80 83 97 374

 mohanvelu.t@boschrexroth.co.in

India - Indien

Bosch Rexroth (India) Ltd.
Electric Drives & Controls
Advance House, II Floor
Ark Industrial Compound
Narol Naka, Makwana Road
Andheri (East), Mumbai - 400 059

Tel.: +91 22 28 56 32 90
+91 22 28 56 33 18

Fax: +91 22 28 56 32 93

singh.op@boschrexroth.co.in

India - Indien

Bosch Rexroth (India) Ltd.
S-10, Green Park Extension
New Delhi – 110016

Tel.: +91 11 26 56 65 25
+91 11 26 56 65 27

Fax: +91 11 26 56 68 87

koul.rp@boschrexroth.co.in

Indonesia - Indonesien

PT. Bosch Rexroth
Building # 202, Cilandak
Commercial Estate
Jl. Cilandak KKO, Jakarta 12560

Tel.: +62 21 7891169 (5 lines)
Fax: +62 21 7891170 - 71
rudy.karimun@boschrexroth.co.id

Japan

Bosch Rexroth Automation Corp.
Service Center Japan
Yutakagaoka 1810, Meito-ku,
NAGOYA 465-0035, Japan

Tel.: +81 52 777 88 41
+81 52 777 88 53
+81 52 777 88 79

Fax: +81 52 777 89 01

Japan

Bosch Rexroth Automation Corp.
Electric Drives & Controls
2F, I.R. Building
Nakamachidai 4-26-44, Tsuzuki-ku
YOKOHAMA 224-0041, Japan

Tel.: +81 45 942 72 10
Fax: +81 45 942 03 41

Korea

Bosch Rexroth-Korea Ltd.
Electric Drives and Controls
Bongwoo Bldg. 7FL, 31-7, 1Ga
Jangchoong-dong, Jung-gu
Seoul, 100-391

Tel.: +82 234 061 813
Fax: +82 222 641 295

Korea

Bosch Rexroth-Korea Ltd.
1515-14 Dadae-Dong, Saha-gu
Electric Drives & Controls
Pusan Metropolitan City, 604-050

Tel.: +82 51 26 00 741
Fax: +82 51 26 00 747
 eunkyong.kim@boschrexroth.co.kr

Malaysia

Bosch Rexroth Sdn.Bhd.
11, Jalan U8/82, Seksyen U8
40150 Shah Alam
Selangor, Malaysia

Tel.: +60  3 78 44 80 00
Fax: +60  3 78 45 48 00
 hockhwa@hotmail.com
 rexroth1@tm.net.my

Singapore - Singapur

Bosch Rexroth Pte Ltd
15D Tuas Road
Singapore 638520

Tel.: +65  68 61 87 33
Fax: +65  68 61 18 25
 sanjay.nemade

@boschrexroth.com.sg

South Africa - Südafrika

TECTRA Automation (Pty) Ltd.
71 Watt Street, Meadowdale
Edenvale 1609

Tel.: +27 11 971 94 00
Fax: +27 11 971 94 40
Hotline: +27 82 903 29 23
 georgv@tectra.co.za

Taiwan

Bosch Rexroth Co., Ltd.
Taichung Industrial Area
No.19, 38 Road
Taichung, Taiwan 407, R.O.C.
Tel : +886 - 4 -235 08 383
Fax: +886 - 4 -235 08 586
 jim.lin@boschrexroth.com.tw
 david.lai@boschrexroth.com.tw

Taiwan

Bosch Rexroth Co., Ltd.
Tainan Branch
No. 17, Alley 24, Lane 737
Chung Cheng N.Rd. Yungkang
Tainan Hsien, Taiwan, R.O.C.

Tel : +886 - 6 –253 6565
Fax: +886 - 6 –253 4754
 charlie.chen@boschrexroth.com.tw

Thailand

NC Advance Technology Co. Ltd.
59/76 Moo 9
Ramintra road 34
Tharang, Bangkhen,
Bangkok 10230

Tel.: +66 2 943 70 62
        +66 2 943 71 21
Fax: +66 2 509 23 62
Hotline +66 1 984 61 52
 sonkawin@hotmail.com
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Nordamerika – North America
USA
Headquarters - Hauptniederlassung

Bosch Rexroth Corporation
Electric Drives & Controls
5150 Prairie Stone Parkway
Hoffman Estates, IL 60192-3707

Tel.: +1 847 6 45 36 00
Fax: +1 847 6 45 62 01
servicebrc@boschrexroth-us.com
 repairbrc@boschrexroth-us.com

USA Central Region - Mitte

Bosch Rexroth Corporation
Electric Drives & Controls
Central Region Technical Center
1701 Harmon Road
Auburn Hills, MI 48326

Tel.: +1 248 3 93 33 30
Fax: +1 248 3 93 29 06

USA Southeast Region - Südwest

Bosch Rexroth Corporation
Electric Drives & Controls
Southeastern Technical Center
3625 Swiftwater Park Drive
Suwanee, Georgia 30124

Tel.: +1 770 9 32 32 00
Fax: +1 770 9 32 19 03

USA SERVICE-HOTLINE

- 7 days x 24hrs -

+1-800-REX-ROTH
+1 800 739 7684

USA East Region – Ost

Bosch Rexroth Corporation
Electric Drives & Controls
Charlotte Regional  Sales Office
14001 South Lakes Drive
Charlotte, North Carolina 28273

Tel.: +1 704 5 83 97 62
+1 704 5 83 14 86

USA Northeast Region – Nordost

Bosch Rexroth Corporation
Electric Drives & Controls
Northeastern Technical Center
99 Rainbow Road
East Granby, Connecticut 06026

Tel.: +1 860 8 44 83 77
Fax: +1 860 8 44 85 95

USA West Region – West

Bosch Rexroth Corporation
7901 Stoneridge Drive, Suite 220
Pleasant Hill, California 94588

Tel.: +1 925 227 10 84
Fax: +1 925 227 10 81

Canada East - Kanada Ost

Bosch Rexroth Canada Corporation
Burlington Division
3426 Mainway Drive
Burlington, Ontario
Canada L7M 1A8

Tel.: +1 905 335 5511
Fax: +1 905 335 4184
Hotline: +1 905 335 5511
 michael.moro@boschrexroth.ca

Canada West - Kanada West

Bosch Rexroth Canada Corporation
5345 Goring St.
Burnaby, British Columbia
Canada V7J 1R1

Tel. +1 604   205 5777
Fax +1 604   205 6944
Hotline: +1 604   205 5777
 david.gunby@boschrexroth.ca

Mexico

Bosch Rexroth Mexico S.A. de C.V.
Calle Neptuno 72
Unidad Ind. Vallejo
07700 Mexico, D.F.

Tel.: +52 55 57 54 17 11
Fax: +52 55 57 54 50 73
mariofelipe.hernandez@boschrexroth.com.mx

Mexico

Bosch Rexroth S.A. de C.V.
Calle Argentina No 3913
Fracc. las Torres
64930 Monterrey, N.L.

Tel.: +52 81 83 65 22 53
+52 81 83 65 89 11
+52 81 83 49 80 91

Fax: +52 81 83 65 52 80

Südamerika –  South America
Argentina - Argentinien

Bosch Rexroth S.A.I.C.
"The Drive & Control Company"
Rosario 2302
B1606DLD Carapachay
Provincia de Buenos Aires

Tel.: +54 11 4756 01 40
+54 11 4756 02 40
+54 11 4756 03 40
+54 11 4756 04 40

Fax: +54 11 4756 01 36
+54 11 4721 91 53

victor.jabif@boschrexroth.com.ar

Argentina - Argentinien

NAKASE
Servicio Tecnico CNC
Calle 49, No. 5764/66
B1653AOX Villa Balester
Provincia de Buenos Aires

Tel.: +54 11 4768 36 43
Fax: +54 11 4768 24 13
Hotline: +54 11 155 307 6781
 nakase@usa.net
 nakase@nakase.com
 gerencia@nakase.com (Service)

Brazil - Brasilien

Bosch Rexroth Ltda.
Av. Tégula, 888
Ponte Alta, Atibaia SP
CEP 12942-440

Tel.: +55 11  4414 56 92
+55 11  4414 56 84

Fax sales: +55 11  4414 57 07
Fax serv.: +55 11  4414 56 86
 alexandre.wittwer@rexroth.com.br

Brazil - Brasilien

Bosch Rexroth  Ltda.
R. Dr.Humberto Pinheiro Vieira, 100
Distrito Industrial    [Caixa Postal 1273]
89220-390 Joinville - SC

Tel./Fax: +55 47 473 58 33
Mobil: +55 47 9974 6645
 prochnow@zaz.com.br

Columbia - Kolumbien

Reflutec de Colombia Ltda.
Calle 37 No. 22-31
Santafé de Bogotá, D.C.
Colombia

Tel.: +57 1 368 82 67
+57 1 368 02 59

Fax: +57 1 268 97 37
reflutec@etb.net.co





  

Bosch Rexroth AG
Electric Drives and Controls
P.O. Box 13 57
97803 Lohr, Germany
Bgm.-Dr.-Nebel-Str. 2
97816 Lohr, Germany
Phone  +49 (0)93 52-40-50 60
Fax  +49 (0)93 52-40-49 41
service.svc@boschrexroth.de
www.boschrexroth.com
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